
Chapter 1

PowerPointing with the 
Best of Them

In This Chapter
� Getting used to the new PowerPoint 2007 interface

� Discovering PowerPoint’s elements

� Creating structure and workflow

� Delving into different types of presentations

� Giving the audience members what they want

Unlike many other applications, PowerPoint is easy to figure out and to
use. And although PowerPoint 2007 is even more amazingly simple to

use than previous versions, this also means that creating terrible presenta-
tions is even easier! Although anyone can create a PowerPoint presentation
with a few words and visuals, you can use PowerPoint to its complete poten-
tial only if you understand the composition of its elements.

All these elements come together to form the structure of a presentation —
but there’s more to a PowerPoint presentation than just structure and the ele-
ments. One of the most important ingredients is the workflow that makes up
the order in which you create and add elements to your presentation.

This chapter first looks at the new PowerPoint 2007 interface. Then it dis-
cusses PowerPoint’s elements, a presentation’s structure, your workflow for
creating a presentation, and more. Although these topics cover theory more
than practical application, spending a little time internalizing these concepts
will take you a long way toward making your finished presentations more
effective and cutting edge.
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And that brings me to what I mean by the term cutting edge. After all, that
term is part of the title of this book. By cutting edge, I mean using simple con-
cepts to create presentations that will work in all situations. The cutting-edge
part here is the results — not that I expect you to create presentations in a
space satellite somewhere outside the earth’s atmosphere! And those types
of results mean that you have to be element-savvy. Later in this chapter, I dis-
cuss these elements — and each of these elements is also discussed in sepa-
rate chapters within this book.

Taking a Look at PowerPoint 2007
Maybe you’ve worked with PowerPoint for the last several versions of the
program, or you might have just started with the program. Either way, you’ll
find that PowerPoint 2007 has a new interface. Gone are the menus and the
toolbars. In their place, you see the Ribbon with all its tabs and galleries. And
yes, you have the Mini Toolbar, as well.

Cut the Ribbon and get started
Figure 1-1 shows you the new PowerPoint interface. It’s actually the embodi-
ment of simplicity, but I still explain its components because I refer to the
interface all through this book!

� Office Button: The Office Button (see Figure 1-1) is a round button
placed on the top left of the interface that works almost the same way as
the File menu in earlier versions of PowerPoint.

� Quick Access toolbar: The Quick Access toolbar is a customizable tool-
bar that can store your often-used commands.

� Ribbon: The Ribbon comprises the area above the actual slide. It
replaces the menus and toolbars in earlier versions of PowerPoint.

� Tabs: The Ribbon is tabbed. You can access each tab by clicking the 
tab header or selecting a particular slide element, which automatically
activates one of the tabs. In addition to the tabs normally visible on 
the Ribbon, contextual tabs appear when a particular slide object is
selected. In Figure 1-1, you can see the Drawing Tools Format tab of the
Ribbon — that’s a contextual tab.

� Buttons: Each of the tabs has several buttons that do something when
clicked — they launch a dialog box, reveal a gallery, change the tab
itself, or just do something on the slide.
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� Groups: Buttons are arranged logically into groups. For example, all the
paragraph formatting options are located within the Paragraph group of
the Home tab of the Ribbon.

� Galleries: Galleries are collections of preset choices. Most of these
choices are in the form of small thumbnail previews that show you how
the final effects will look. Many galleries can also be seen as drop-down
galleries so that you can see even more thumbnail previews.

� Dialog box launcher: Dialog box launchers are small arrows below some
groups that launch a related dialog box.

� Status bar: The status bar provides information and viewing options.

Office
Button

Ribbon

Quick Access Toolbar

Tab Dialog launcher

Status bar Group Gallery

Figure 1-1:
The new
interface

works the
same way in
PowerPoint

as it does 
in the 

Office 2007
versions of

Word and
Excel.
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The Mini Toolbar
So what is a Mini Toolbar? As much as you might like that mini bar in your
hotel room, I promise you this one is more helpful! If you select some text in
PowerPoint, you’ll see a semitransparent floating toolbar that provides all the
text formatting options you need without having to make a trip to the Home
tab of the Ribbon. That’s the Mini Toolbar.

Figure 1-2 shows you the Mini Toolbar in all its resplendent glory. Just move
the cursor away or deselect the text, and the Mini Toolbar gets sad and goes
away. If you want to get it back again and it’s in no mood to come back, you
can always right-click the selected text to order it back into your esteemed
presence.

The Elements of PowerPoint
When you open PowerPoint, it presents you with a blank canvas that you
color with your ideas and your message. The brushes and paints used to
transform this blank canvas into an amazing interactive medium are its ele-
ments of composition:

� Text

� Background, images, and info-graphics

� Shapes

� Fills, lines, and effects

� Sound and video

� Animations and transitions

� Interactivity, flow, and navigation

If you’ve heard or read any of those “Death by PowerPoint” cries in the media
these days that bemoan the lack of aesthetics in PowerPoint presentations
shown all over the world, you need to make friends with all the elements of
PowerPoint so that you can use these elements more effectively to create
more aesthetic PowerPoint presentations.

Figure 1-2:
Here comes

the Mini
Toolbar.
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In the following sections, I explain more about these individual elements and
then follow it up with how they team together to form an entire presentation
workflow. I discuss each of these elements in greater depth in separate chap-
ters throughout this book.

Text
Text is the soul of a presentation — it relates to content like nothing else.
Your text could be in the form of titles, subtitles, bullets, phrases, captions,
and even sentences.

A barrage of visual content might not be able to achieve what a single effec-
tive word can say — sometimes, a word is worth a thousand pictures. Text is
significant because it means you have something to say. Without explicit text,
what you’re trying to say might not come through as strongly as you want.

Too much text is like too much of any good thing — it can be harmful. For
example, a slide with 20 lines of teeny-weeny text just doesn’t work. The audi-
ence can’t read it, and the presenter doesn’t have time to explain that much
content! Anyway, if you’re cramming so much text on a slide, you’ve already
lost the focus of your presentation.

Backgrounds, images, and info-graphics
PowerPoint uses three types of graphical elements:

� Backgrounds: The backdrop for your slides. Backgrounds need to be
understated.

You can create a great presentation with a plain white background. On
the other hand, artistic backgrounds are a great way to bring a presenta-
tion to life.

The new themes in PowerPoint 2007 also let you recolor background
graphics by applying new Theme Colors. These are explained in more
detail in Chapter 3.

� Pictures: Images that you insert in slides. Pictures share the stage 
with text.

� Info-graphics: Images that combine visuals and text to make complex
information and statistics easier to understand. Info-graphics include
charts, tables, maps, graphs, diagrams, organization charts, timelines,
and flowcharts. You can also create info-graphics in a separate program,
such as SmartDraw or Visio, and bring them into PowerPoint later.
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Images and text always work together — collectively, they achieve more than
the sum of each other’s potential. However, images need to be relevant to the
subject and focused; using an unsuitable visual is worse than using no visual
at all. The same rules apply to info-graphics, as well.

PowerPoint provides many ways to present images — from recolored styles,
effects, and outlines to animations and builds.

Shapes
Simple objects such as circles, rectangles, and squares can help you explain
concepts so much better. PowerPoint looks at the entire shape concept in a
different way through its Shapes gallery. The shapes within the Shapes
gallery seem like regular lines and polygons, but that’s where the similarity
ends; they are very adaptable in editing and creation. Shapes can also 
function as building blocks and form the basis of complex diagrams and 
illustrations.

Fills, lines, and effects
Shapes, pictures, and even info-graphics in PowerPoint can stand out from
the slide by using as assortment of fill, line, and effect styles. Most styles are
found in galleries on the Ribbon tabs.

Sound and video
PowerPoint provides many ways to incorporate sound: inserted sounds,
event sounds, transition sounds, background scores, and narrations.

PowerPoint was perhaps never intended to become a multimedia tool — nor
were presentations ever imagined to reach the sophisticated levels they have
attained. Microsoft has tried to keep PowerPoint contemporary by adding
more sound capabilities with every release. This version finally makes it
easier to work with sound in PowerPoint by adding a whole new Ribbon tab
containing sound options.

As computers get more powerful and play smooth full-screen video, viewers
expect PowerPoint to work with all sorts of video formats. But that’s a far 
cry from reality. In Chapter 11, I look at workarounds that keep PowerPoint
happy with all sorts of video types.
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Animations and transitions
Animations and transitions fulfill an important objective: introducing several
elements one at a time in a logical fashion to make it easier for the audience
to understand a concept. Keep these guidelines in mind when using anima-
tions and transitions:

� Animation is best used for a purpose. An example would be using anima-
tion to illustrate a process or a result of an action.

If you use animation without a purpose, your presentation might end up
looking like an assortment of objects that appear and exit without any
relevance.

� Transitions can be either subdued or flashy depending on the flow of
ideas being presented. In either case, they need to aid the flow of the
presentation rather than disrupt it.

Animations and transitions are covered in Chapter 12.

Interactivity, flow, and navigation
Amazingly, interactivity, flow, and navigation are the most neglected parts of
many PowerPoint presentations. These concepts are easy to overlook
because, unlike a picture, they aren’t visible:

� Interactivity, in its basic form, is the use of hyperlinks within a presenta-
tion to link to

• Other slides in a presentation

• Other documents outside a presentation (such as Word files)

� Flow is the spread of ideas that evolves from one slide to the next. Flows
can be smooth or abrupt.

� Navigation aids interactivity. It is the way your presentation is set up to
provide one-click access for the user to view other slides in the correct
order.

Navigation is mostly taken care of by using the PowerPoint Action
Buttons, but you can link from any PowerPoint object to move from one
slide to the next.
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Interactivity and linking are covered in Chapter 13. Good flow concepts are
influenced by proper use of consistency and animation. Consistency is 
covered in Chapter 4, and animation is covered in Chapter 12.

Going Outside PowerPoint to Create
Presentation Elements

Although you might believe that all the elements of a cutting-edge presentation
are accessible from within PowerPoint, that’s not entirely true. Professional
presentation design houses don’t want you to know the secret of using non-
PowerPoint elements in your presentation — this knowledge is often the 
difference between a cutting-edge presentation and an ordinary one!

Examples of non-PowerPoint elements include the following:

� Images retouched and enhanced in an image editor, such as Adobe
Photoshop

� Charts created in a dedicated charting application

� Music and narration fine-tuned, amplified, and normalized in a sound
editor

� Video clips rendered in a custom size and time in a video-editing 
application

� Animations created in a separate application, such as Macromedia Flash

When these non-PowerPoint elements are inserted inside PowerPoint, most
of them can be made to behave like normal PowerPoint elements.

Structure and Workflow
The words structure and workflow might sound a little intimidating, but they
are merely a way of ensuring that your presentation elements are working
together.
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Presentation structure
A typical presentation structure combines the elements I mention at the
beginning of this chapter into something like what you see in Figure 1-3.

Figure 1-3 is just an example — almost every presentation has a unique struc-
ture depending on the content of the presentation and the audience. On the
other hand, the presentation workflow for most presentations remains
unchanged, which is what I explain next.

Presentation workflow
The presentation workflow decides the sequence of the elements that I
explain earlier in this chapter. In addition, it includes some more abstract ele-
ments such as delivery and repurposing. Chapters 14 and 15 discuss these
vital concepts.

Figure 1-4 shows a typical presentation workflow.

As you can see, the workflow begins with concept and visualization and ends
with delivery and repurposing. But that’s not entirely true — repurposing can
often be the same as the concept and visualization of another presentation!
That’s food for thought — and the stimulus for thoughts on another interest-
ing subject. . . .

Slide SlideSlide

VisualsVideo

Transitions Sound

Slide

Figure 1-3:
A typical

presentation
structure.
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What Can You Use PowerPoint For?
You can use PowerPoint to create all sorts of presentations:

� Business presentations: More than anything else, people use PowerPoint
to create presentations intended for the boardrooms and conference
halls of the corporate world, where people of all sorts come to see and
hear content. And as those in corporate corridors have discovered, the
most important thing is to have a PowerPoint presentation ready for
every proposal and product — and I should add sales and service to
that list!

� Homework projects: Don’t be flabbergasted if your kid asks you to help
create a presentation for school. Or maybe you are a kid reading this
and can’t understand what’s so great about creating a PowerPoint pre-
sentation for a project. Schools all over the world are discovering the
virtues of PowerPoint — the program lets you assemble all sorts of
media, such as images, text, and sound, in one document. And think
about the amount of paper and ink you save by replacing that project
poster with a PowerPoint presentation!

Figure 1-4:
A typical

presentation
workflow.
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� Educational content: Colleges and universities commonly have their
own banks of presentations for every conceivable subject. Some of these
presentations are sold for very high prices as “talks” by specialized 
vendors — and the high prices are because these talk presentations
were created by highly renowned professionals. Even at the high cost,
these talk presentations are a steal because they’re the next best thing
to inviting those professors to speak to your students.

� Kiosks: Kiosks can display anything and everything nowadays — from
travel information at airports to the playlist at the coffee shop jukebox.
And many of those kiosk displays are actually PowerPoint presentations.

� Religious presentations: And now for the godly frontiers — that projec-
tion of the hymn lyrics in church was likely created in PowerPoint. So
was that fancy slide show that displayed pictures from the missionary
trip to South America.

� Government presentations: PowerPoint is used everywhere in the
administrative sphere. Be it presidents or prime ministers — or even
organizations like the United Nations and its various agencies all over
the world — so much these days happens on a PowerPoint slide. And
yes, when something goes wrong, such as space shuttle disasters,
PowerPoint often is given some of that blame!

� Multimedia demos: This is probably the most controversial use because
PowerPoint was never intended to be used as a tool to create multime-
dia demos that run from CD-ROM. Nevertheless, PowerPoint allows
interactivity and navigation between slides — and because so many
people already have PowerPoint, all those bosses decided that they
might as well ask untrained office staff to put it to good use!

Of course, you can use PowerPoint for so much more — electronic greeting
cards, quizzes, posters, and even multiplication tables. You’re limited only 
by your imagination. PowerPoint is a great tool to present your ideas.

Giving People What They Like to See
The simplest secret of creating great presentations is to give audiences what
they like to see. If you give them anything else, they’re bound to complain
with bouts of loud-mouthed vengeance and stupidity. Okay — I admit that
was an exaggeration. They’re more likely to doze off and snore loudly while
you’re presenting!

So what do audiences like to see? That’s what I discuss next.
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Truth and sincerity
More than anything else, audiences want sincerity and truth. Just because
you put that sentence in a 48-point bold font in a contrasting color doesn’t
mean that your audience will believe what it says. If there’s something in
common among audiences of any place, age, and sex, it’s that they want
something they can believe — and if there’s even a hint that something men-
tioned in your presentation is gobbledygook, you can wave goodbye to the
remaining 999 slides in that presentation! (And please don’t make such long
presentations.)

Of course, there are rare exceptions to that rule. A few centuries ago, audi-
ences didn’t believe that the earth was round — or that people could find a
way to fly. If what you’re presenting is similarly groundbreaking, I’ll let you
put that in your next PowerPoint presentation. And I’m so proud that you are
reading this book.

Never use any content that can be thought of as discriminatory toward race,
gender, age, religious beliefs, weight, and so on. Not only will discriminatory
phrases or even images reflect badly on you, they’ll also hijack the entire
focus of your presentation.

Style and design
To enliven your message, use as many of these style and design guidelines as
you can balance on a single PowerPoint slide:

� Choose an uncluttered background for your presentation.

• Plain color backgrounds get around that clutter problem just by
being plain!

• Other background types, such as textures, gradients, and pho-
tographs, have to be more carefully chosen.

Test your background choice by inserting enough placeholder text in an
18-point font size to fill the entire slide area in two slides. Use black text
on one slide and white text on the other. If you can read text on both the
slides clearly, your background really works! If just one color works, you
can use that background if you make sure that you use the right colors
for all other slide objects. See Chapter 3 to find out more about picking
the right colors.
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� Make sure your text is large enough that it can be read even by the
audience members in the last row. You don’t want to make anyone in
the audience squint to read your slides!

� Make sure that you use just the right amount of visual content to get
your message across. Don’t use too little and certainly don’t use too
much.

• Don’t add 16 pictures when a few are enough.

• Use only relevant content; don’t waste your audience’s time and
energy (or yours, for that matter) on images that have nothing to
do with the topic of discussion.

� Make sure that any sounds you insert in your presentation all play 
at the same volume. You don’t want the sound on one slide to be low
and then follow that with a sound that’s loud enough to wake up your
ancestors.

Correct spelling, accurate grammar, 
and good word choice
Nothing is as embarrassing and shameful as a misspelling on a slide — 
especially considering that PowerPoint includes an excellent spell checker.
But even beyond the spell checker, make sure that the spellings work for the
country and audience you are presenting to. Thus, color is perfectly fine in
the United States, but make that colour if you’re presenting in the United
Kingdom or in India.

Avoid repeating the same word on a slide when possible. For example, if you
see a phrase like “report results in weekly reports,” you need to do some edit-
ing! You can use PowerPoint’s thesaurus (accessible on the Review tab of the
Ribbon) to find alternatives if you find yourself repeating certain words.

Don’t read the slide aloud to your audience while you’re giving your presen-
tation. Slight differences in language and wording can make all the difference.
Audiences want you to take the content further by sharing your experiences,
opinions, and ideas on the subject.
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